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Application Scenarios

APIG involves the following development scenarios:

e API calling authentication: For APIs that use app or IAM authentication, API
calling authentication should be developed for the service system to add
authentication information to API requests.

- API calling through app authentication (signature authentication):
API callers provide a key, secret, and SDK through APIG to complete
signature authentication for their API requests.

- API calling through IAM authentication (token authentication): API
callers obtain a token from the cloud service platform and add the token
to their API requests.

- API calling through IAM authentication (AK/SK authentication): API
callers sign their API requests using AK (Access Key ID) /SK (Secret Access
Key) and SDKs provided by APIG.

e  Function for custom authentication: When using the custom authentication
mode, create a function in FunctionGraph for authentication.

- Function for frontend custom authentication: APIG uses the function
to perform security authentication on received API requests.

- Function for backend custom authentication: The API backend service
uses the function to perform security authentication on API requests
forwarded by APIG.

e Signature verification by backend service: If an APl is bound with a
signature key on APIG, the request sent by APIG to the backend service of the
API carries the corresponding signature information. The backend service of
the APl must integrate the SDK provided by APIG and verify the signature
information in the request.
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Calling APIs Through App
Authentication

2.1 Preparation

Before calling APIs in app authentication mode, complete the following
operations:

Obtain API request information

On the console of a gateway, choose APl Management > APIs, and click an
APl name to go to the details page. On the APIs tab, view the domain name,
request path, and request method.

Publish APIs in an environment

On the console of a gateway, choose APl Management > APIs, and click an
APl name to go to the details page. On the APIs tab, navigate to Frontend
Configuration > Frontend Definition, and view the environment in which the
API has been published.

Obtain API authentication information

To sign an API request cryptographically through app authentication
(signature authentication), the key and secret of a credential authorized to
call the API are required. On the console of a gateway, choose API
Management > Credentials. Go to the details page of a credential, and
obtain the key and secret.

(11 NOTE

e AppKey or Key: access key ID of an app. It is the unique ID associated with a secret
access key. The access key ID and secret access key are together used to obtain an
encrypted signature for a request.

e AppSecret or Secret: secret access key used together with an access key ID to sign
requests. The access key ID and secret access key can be together used to identify
a request sender to prevent the request from being modified.

When sending an API request, add the current time to the X-Sdk-Date header
and the signature information to the Authorization header.
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/A\ CAUTION

The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

APIG checks the time format and compares the time with the time when APIG
receives the request. If the time difference exceeds 15 minutes, APIG will
reject the request.

2.2 App Authentication

1. Construct a standard request.

Assemble the request content according to the rules of APIG (API
Management), ensuring that the client signature is consistent with that in the
backend request.

2. Create a to-be-signed string using the standard request and other related
information.

3. Calculate a signature using the AK/SK and to-be-signed string.

4. Add the generated signature to an HTTP request as a header or query
parameter.

5. After receiving the request, APIG performs 1 to 3 to calculate a signature.

6. The new signature is compared with the signature generated in 3. If they are
consistent, the request is processed; otherwise, the request is rejected.

(11 NOTE

The body of a signing request in app authentication mode cannot exceed 12 MB.

Step 1: Constructing a Standard Request

To access an API through app authentication, standardize the request content, and
then sign the request. The client must follow the same request specifications as
APIG so that each HTTP request can obtain the same signing result from the
frontend and backend to complete identity authentication.

The pseudocode of standard HTTP requests is as follows:

CanonicalRequest =
HTTPRequestMethod + '\n' +
CanonicalURI + '\n' +
CanonicalQueryString + '\n' +
CanonicalHeaders + '\n' +
SignedHeaders + '\n' +
HexEncode(Hash(RequestPayload))

The following example shows how to construct a standard request.

Original request:

GET https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?b=28&a=1 HTTP/1.1
Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
X-Sdk-Date: 20191111T093443Z

1. Specify an HTTP request method (HTTPRequestMethod) and end with a
carriage return line feed (CRLF).
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For example:
GET

Add a standard URI (CanonicalURI) and end with a CRLF.

Description

Path of the requested resource, which is the URI code of the absolute path.
Format

According to RFC 3986, each part of a standard URI except the redundant and
relative paths must be URI-encoded. If a URI does not end with a slash (/),
add a slash at its end.

Example

For the URI /app1, the standard URI code is as follows:
GET
/app1/

(11 NOTE

During signature calculation, the URI must end with a slash (/). When a request is
sent, the URI does not need to end with a slash (/).

Add a standard query string (CanonicalQueryString) and end with a CRLF.
Description

Query parameters. If no query parameters are configured, the query string is
an empty string.

Format

Standard query strings must meet the following requirements:

- Perform URI encoding on each parameter and value according to the
following rules:

® Do not perform URI encoding on any non-reserved characters
defined in RFC 3986, including A-Z, a-z, 0-9, hyphen (-), underscore
(1), period (.), and tilde (~).

" Use %XY to perform percent encoding on all non-reserved
characters. X and Y indicate hexadecimal characters (0-9 and A-F).
For example, the space character must be encoded as %20, and an
extended UTF-8 character must be encoded in the "%XY%ZA%BC"
format.

- Add "URI-encoded parameter name = URI-encoded parameter value" to
each parameter. If no value is specified, use a null string instead. The
equal sign (=) is required.

For example, in the following string that contains two parameters, the
value of parameter parm2 is null.

parm1=valuel&parm2=

- Sort the parameters in alphabetically ascending order. For example, a
parameter starting with uppercase letter F precedes another parameter
starting with lowercase letter b.

- Construct standard query strings from the first parameter after sorting.
Example
The following example contains two optional parameters a and b.
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GET

/app1/
a=1&b=2

Add standard headers (CanonicalHeaders) and end with a CRLF.
Description

List of standard request headers, including all HTTP message headers in the
to-be-signed request. The X-Sdk-Date header must be included to verify the
signing time, which is in the UTC time format YYYYMMDDTHHMMSSZ as
specified in ISO 8601. When publishing an API in a non-RELEASE
environment, you need to specify an environment name.

NOTICE

The local time on the client must be synchronized with the clock server to
avoid a large error in the value of the X-Sdk-Date request header.

APIG checks the time format and compares the time with the time when APIG
receives the request. If the time difference exceeds 15 minutes, APIG will
reject the request.

Format

CanonicalHeaders consists of multiple message headers, for example,
CanonicalHeadersEntry0 + CanonicalHeadersEntry1 + .... Each message
header (CanonicalHeadersEntry) is in the format of
Lowercase(HeaderName) + "' + Trimall(HeaderValue) + '\n'.

(11 NOTE

e Lowercase: a function for converting all letters into lowercase letters.
e Trimall: a function for deleting the spaces before and after a value.

e The last message header carries a CRLF. Therefore, an empty line appears because
the CanonicalHeaders field also contains a CRLF according to the specifications.

e The message header name must be unique. Otherwise, authentication fails.

Example

GET

/app1/

a=1&b=2
host:c967a237-cd6¢c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z
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NOTICE

Standard message headers must meet the following requirements:

e All letters in a header are converted to lowercase letters, and all spaces
before and after the header are deleted.

e All headers are sorted in alphabetically ascending order.

For example, the original headers are as follows:

Host: c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
Content-Type: application/json;charset=utf8\n

My-header1: a b ¢ \n

X-Sdk-Date:20191111T093443Z\n

My-Header2: "a b c" \n

A standard header is as follows:

content-type:application/json;charset=utf8\n
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com\n
my-headerl:a b c\n

my-header2:"a b c"\n

x-sdk-date:20191111T093443Z\n

Add message headers (SignedHeaders) for request signing, and end with a
CRLF.

Description

List of message headers used for request signing. This step is to determine
which headers are used for signing the request and which headers can be
ignored during request verification. The X-Sdk-date header must be included.

Format

SignedHeaders = Lowercase(HeaderNameO0) + ;' + Lowercase(HeaderName1)
+ mn.n + .

’

Letters in the message headers are converted to lowercase letters. All headers
are sorted alphabetically and separated with commas.

Lowercase is a function for converting all letters into lowercase letters.
Example

In the following example, two message headers host and x-sdk-date are used
for signing the request.

GET

/app1/

a=1&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date

Use the hash function SHA-256 to create a hash value based on the body
(RequestPayload) of the HTTP or HTTPS request.

Description

Request message body. The message body needs two layers of conversion
(HexEncode(Hash(RequestPayload))). Hash is a function for generating
message digest. Currently, SHA-256 is supported. HexEncode: the Base16
encoding function for returning a digest consisting of lowercase letters. For
example, HexEncode ("m") returns 6d instead of 6D. Each byte you enter is
expressed as two hexadecimal characters.
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(11 NOTE

If RequestPayload is null, the null value is used for calculating a hash value.
Example

This example uses GET as an example and leaves the request body empty.
After hash processing, the request body (empty string) is as follows:

GET

/app1/

a=18&b=2
host:c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com
x-sdk-date:20191111T093443Z

host;x-sdk-date
e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855

7. Perform hash processing on the standard request in the same way as that on
the RequestPayload. After hash processing, the standard request is expressed

with lowercase hexadecimal strings.

Algorithm pseudocode:
Lowercase(HexEncode(Hash.SHA256(CanonicalRequest)))

Example of standard request after hash processing:
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155¢0

Step 2: Creating a To-Be-Signed String

After a standard HTTP request is constructed and the request hash value is
obtained, create a to-be-signed string by combining them with the signature
algorithm and signing time.
StringToSign =

Algorithm + \n +

RequestDateTime + \n +
HashedCanonicalRequest

Parameters in the pseudocode are described as follows:

e Algorithm
Signature algorithm. For SHA256, the value is SDK-HMAC-SHA256.
e RequestDateTime

Request timestamp, which is the same as X-Sdk-Date in the request header.
The format is YYYYMMDDTHHMMSSZ.

e HashedCanonicalRequest

Standard request generated after hash processing.
In this example, the following to-be-signed string is obtained:
SDK-HMAC-SHA256

20191111T093443Z
af71c5a7ef45310b8dc05ab15f7da50189ffa81a95cc284379ebaa5eb61155c0

Step 3: Calculating the Signature

Use the AppSecret and created character string as the input of the encryption
hash function, and convert the calculated binary signature into a hexadecimal
expression.

The pseudocode is as follows:
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signature = HexEncode(HMAC(APP secret, string to sign))

HMAC indicates hash calculation, and HexEncode indicates hexadecimal
conversion. Table 2-1 describes the parameters in the pseudocode.

Table 2-1 Parameter description

Parameter Description

AppSecret Signature key.

To-be-signed string | Character string to be signed.

If the AppSecret is FWTh5tqu2Pb9ZGt8NI09XYZti2V1LTa8useKXMDS8, the
calculated signature is as follows:

01cc37e53d821da93bb7239¢c5b6e1640b184a748f8c20e61987b491e00b15822

Step 4: Adding the Signature to the Request Header

2.3 Java

Scenarios

Add the signature to the HTTP Authorization header. The Authorization header is
used for identity authentication and not included in the signed headers.

The pseudocode is as follows:

Authorization header creation pseudocode:
Authorization: algorithm Access=APP key, SignedHeaders=SignedHeaders, Signature=signature

There is no comma before the algorithm and Access. SignedHeaders and
Signature must be separated with commas.

The signed headers are as follows:

Authorization: SDK-HMAC-SHA256 Access=FM9RLCN****++++xixNAX|SK, SignedHeaders=host;x-sdk-date,
Signature=01cc37e53d821da93bb7239c5b6e1640b184a748f8c20e61987b491e00b15822

The signed headers are added to the HTTP request for identity authentication. If
the identity authentication is successful, the request is sent to the corresponding
backend service for processing.

To use Java to call an API through app authentication, obtain the Java SDK, create
a project or import an existing project, and then call the API by referring to the
API calling example.

This section uses Eclipse 4.5.2 as an example.
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Prerequisites

Figure 2-1 API calling process
Start

L
Obtain the SDK.

l

¥
Create a project. IR T Y]
project.

¥
Call the APL.

L]
End

e You have obtained API calling information. For details, see Preparation.

e You have installed Eclipse 3.6.0 or a later version. If not, download Eclipse
from the official Eclipse website and install it.

e You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it. JDK 17 or

later is not supported.

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-java-sdk.zip package. The following table shows

the files decompressed from the package.

Name

Description

libs\

SDK dependencies

libs\java-sdk-core-x.x.xjar

SDK package

src\com\apig\sdk\demo\Main.java

src\com\apig\sdk\demo\OkHttpDemo.java

src\com\apig\sdk\demo\LargeFileUpload-
Demo.java

Sample code for signing requests

.classpath

.project

Java project configuration files
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Importing a Project
Step 1 Open Eclipse and choose File > Import.

The Import dialog box is displayed.

Step 2 Choose General > Existing Projects into Workspace and click Next.

The Import Projects dialog box is displayed.

Figure 2-2 Importing a project

& Import

Select

Create new projects from an archive file or directory,

Select an import source:

type filter text

o [ e
(L]

4 (= General
JE Archive File
|[ﬁ Existing Projects into Waorkspace

[, File System

[} Preferences
> = Git
= Gradle

m

. - —
":?/' = Back Mext = Finish

Step 3 Click Browse and select the directory where the SDK is decompressed.

2023-12-19
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Figure 2-3 Selecting the demo project

S Import = &=
Import Projects E f
-

Select a directory to search for existing Eclipse projects.

@ Select root directory: | DtYjava©\ApiGateway-java-sdk- - Browse... l
() Select archive file: Browse...
Projects:

java-sdk-demo (D¥\java\ApiGateway-java-sdhk- I Select All

Deselect All

Refresh

i

Options
[[] Search for nested projects
[ Copy projects into workspace
[[|Hide projects that already exist in the workspace
Working sets
[[] Add project to working sets

Select...

'i?::' Mext = Finish ] ’ Cancel

Step 4 Click Finish.

Modify the parameters in sample code Main.java as required. For details about
the sample code, see API Calling Example.

--—-End

Creating a Project
Step 1 Open Eclipse and choose File > New > Java Project.
The New Java Project dialog box is displayed.

Step 2 Enter a project name, for example, java-sdk-demo, retain the default settings for
other parameters, and click Finish.
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Figure 2-4 Creating a project

&= New Java Project = I@
Create a Java Project —
Create a Java project in the workspace or in an external location.

Project name: java-sdk-demo

Use default location

Ch\Users), \workspaceljava-sdk-demo Browse...
JRE
@ Use an execution enviranment JRE: JavaSE-1.8 -
i7) Use a project specific JRE: jrel.8.0 191
(71 Use default JRE {currently jrel.8.0 191" Configure JREs...

Project layout

71 Use project folder as root for sources and class files

@ Create separate folders for sources and class files  Configure default...

Working sets
[[] Add project to working sets

Select...

@' = Back Mext = ] [ Finish l ’ Cancel

Step 3 Import the .jar files in the APIG Java SDK.

1. Choose java-sdk-demo, right-click, and choose Build Path > Add External
Archives from the shortcut menu.
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2.

Figure 2-5 Importing the .jar files

4 |l java=dl-d '
'FLE%’ g Mew 4
b o J Go Into
Open in New Window
Dpen Type Hierarchy F
Show In Alt+Shift+W ¥
Copy Ctrl+C
EZ  Copy Qualified Name
[} Paste Cirl+V
H  Delete Delete
Remove from Context Ctrl+Alt+Shift+Down
Build Path 1 v | Zm  Link Source...
Source Alt+Shift+S v | &9 MNew Source Folder...
Refactor Alt+Shift+T » 6B Use as Source Folder
i Import.. 2 s Add External Archives...
g Export.. =\ Add Libraries...
«5 Refresh FS | g Configure Build Path...

Select all .jar files in the \libs directory.

Figure 2-6 Selecting all .jar files

| commons-codec-1.11jar 2019/3/15 10:23  Executable Jar File 328 KB|
| =] commons-logging-1.2jar 2019/3/15 10:23 Executable Jar File 61 KB |
| =] httpclient-4.5.5.jar 2019/3/15 10:23  Executable Jar File 749 KB |
| ] httpcore-4.4.9.jar 2019/3/15 10:23  Executable Jar File 318 KB|
| =] java-sdk-core-3.0.9.jar 2019/3/15 10:23  Executable lar File 101 KB |
| 2] joda-time-2.9.9,jar 2019/3/15 10:23  Executable Jar File 620 KB |
| €] okhttp-3.11.0,jar 2019/3/15 10:23  Executable Jar File 404 KB |
| =] okio-1.15.0,ar 2019/3/15 10:23  Executable Jar File 87 KB |

Step 4 Create a package and Main file.

1. Choose src, right-click, and choose New > Package from the shortcut menu.

Figure 2-7 Creating a package
4 (= java-sdk-demo

blfﬁ—; 1 ¥ |22 Java Project
4 = R Open in New Window wi |z
b fme Open Type Hierarchy F4 2
b 'E Show In Alt+Shift+ W | & Class
E :; Copy Ctrl+C € Interface
« B B3 | Conv Oualfied Name B

2. Enter com.apig.sdk.demo for Name.
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Figure 2-8 Setting a package name

& Mew Java Package | = '@

Java Package
Create a new Java package.

Creates folders corresponding to packages.

Source folder: java-sdk-demojfsrc

Mame: com.apig.sdk.demo

[| Create package-infojava

@' Einish l ’ Cancel

3. Click Finish.
The package is created.

4. Choose com.apig.sdk.demo, right-click, and choose New > Class from the
shortcut menu.

Figure 2-9 Creating a class
4 [ java-sdk-demao

4 (B grg
E . L 1 I

- @ JRE 1 | 2% Java Project
4 m) Refe Open in New Window [ Project..

¢ fma g Open Type Hierarchy F4 | §F Package

» 59 Showln Alt+Shift+W » 2

> foig }‘

. oy H 2 Copy cirlec | G Interface

> g i B Copy Qualified Name & Enum

. s ji [ Paste Ctrl+V ® Annotation

5. Enter Main for Name and select public static void main(String[] args).
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Figure 2-10 Configuring the class

= New Java Class

5]l

]

Java Class =
Create a new Java class.
Source folder: Java-sdk-demo/src
com.apig.sdk.demo
Browse...

Package:

[[]Enclosing type:

Modifiers: @ public (") package private protected
[] abstract [ final static
Superclass: java.lang.Object
Interfaces: Add...
Eemove
Which method stubs would you like to create?
| [lipublic static void main(String[] args);
[7] Constructors from superclass
[¥] Inherited abstract methods
Do you want to add comments? (Configure templates and default value here
|:| Generate comments
[ Cancel

l

Finish

@

6. Click Finish.
The Main file is created.

Step 5 View the directory structure of the project.

15
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Figure 2-11 Directory structure of the new project Main

4 (=2 java-sdk-demo
4 [ src
4 B} com.apig.sdlk.demo
[ 4] Mainjavai|
» @l JRE System Library [JavaSE-1.8]

4 @), Referenced Libraries

» jw commons-codec-1.11jar - [
» jms commons-logging-1.2,jar -|[:

o hitpclient-4.3.5.jar - Ot javalAp

* ol

oy hitpcore-4.4.9,jar - Dd\java\Ppi

o

o java-sdk-core-3.0.9 jar - 0:]jav

* ol

joda-time-2.9.9jar - D javd\Af
okhttp-3.11.0jar - O\java'\4pic

s okio-1.15.0.jar - v\ java'\Ap]Ga

o

=

* ol

=l

o

Before using Main.java, enter the required code according to the API calling
example provided in this section.

--—-End

API Calling Example
(11 NOTE

e You need to create an APl with the Mock backend on the console, and then publish the
API. For details about how to create and publish an API, see the AP/ Gateway User
Guide.

e The backend of this APl is a fake HTTP service, which returns response code 200 and
message body Congratulations, sdk demo is running.

Step 1 Add the following references to Main.java:

import java.io.lOException;
import javax.net.ssl.SSLContext;

import org.apache.http.Header;

import org.apache.http.HttpEntity;

import org.apache.http.HttpResponse;

import org.apache.http.client.methods.HttpRequestBase;
import org.apache.http.conn.ssl.AllowAllHostnameVerifier;
import org.apache.http.conn.ssl.SSLConnectionSocketFactory;
import org.apache.http.conn.ssl.SSLContexts;

import org.apache.http.conn.ssl.TrustSelfSignedStrategy;
import org.apache.http.impl.client.CloseableHttpClient;
import org.apache.http.impl.client.HttpClients;

import org.apache.http.util.EntityUtils;

import com.cloud.apigateway.sdk.utils.Client;
import com.cloud.apigateway.sdk.utils.Request;

Step 2 Construct a request by configuring the following parameters:

e AppKey: Obtain it by referring to Preparation. The sample code uses
4f5f****100c.
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Step 3

e AppSecret: Obtain it by referring to Preparation. The sample code uses ******,

e Method: Specify a request method. The sample code uses POST.

e url: Request URL of the API, excluding the QueryString and fragment parts.
Use your own independent domain name. The sample code uses http://
€967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/java-
sdk.

e queryString: Specify query parameters to be carried in the URL. Characters
(0-9a-zA-Z./;[1\-=~#%"&_+:") are allowed. The sample code uses
name=value.

e header: Specify request headers. The sample code uses Content-Type:text/

plain. If you are going to publish the APl in a non-RELEASE environment,
specify an environment name. The sample code uses x-
stage:publish_env_name.

e body: Specify the request body. The sample code uses demo.

The sample code is as follows:

Request request = new Request();

try
{
request.setKey ("415***100c"); //Obtained when an app is created.
request.setSecret(" ****"'); //Obtained when an app is created.
request.setMethod("POST");
request.setUrl(" http.//c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.comy/java-
sdk");
//URL
request.addQueryStringParam(" name", "value");
request.addHeader (" Content-Type", "text/plain");
//request.addHeader (" x-stage", " publish_env_name"); //Specify an environment name before
publishing the API in a non-RELEASE environment.
request.setBody("demo");
} catch (Exception e)
{
e.printStackTrace();
return;

}

Sign the request, access the API, and print the result.

The sample code is as follows:
CloseableHttpClient client = null;
try
{
HttpRequestBase signedRequest = Client.sign(request);

client = HttpClients.custom().build();

HttpResponse response = client.execute(signedRequest);
System.out.println(response.getStatusLine().toString());
Header[] resHeaders = response.getAllHeaders();

for (Header h : resHeaders)

{

}

HttpEntity resEntity = response.getEntity();
if (resEntity != null)

{

}

System.out.println(h.getName() + ":" + h.getValue());

System.out.println(System.getProperty("line.separator") + EntityUtils.toString(resEntity, "UTF-8"));

} catch (Exception e)

{
e.printStackTrace();

} finally
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Step 4 Choose Main.java, right-click, and choose Run As > Java Application to run the

try
if (client != null)
client.close();

} catch (IOException e)
{

}
}

e.printStackTrace();

project test code.

Figure 2-12 Running the project test code

e

4 [ java-sdk-demo
> @ JRE System Library [jre1.8.0_191]
4 (B src
4 i com.apig.sdk.demo
> ] LargeFileUploadDema.java

/{Import the external dependencies.
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i, 6% import java.io.IOException;[]

> |ad] M
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> @, Referenc Open F3
s (= libs Open With '
2/ changelg Open Type Hierarchy F4
Show In Alt+Shift+W »
& Copy Ctrl+C
2 Copy Qualified Name
& Paste Cirl+V
H Delete Delete

Remaove from Context
Build Path
Source

Refactor

g Import.

3 Export.

=

References

Declarations

" Refresh

Debug As

Vialidas~

Assign Working Sets...

Ctrl+Alt+Shift+ Down
3
Alt+Shift+5 »
Alt+Shift+T »

F5

-

main(string[] args) {
request.
= new Request();

equest parameters.

ppSecrect, Method and Url are required
ey("871fe245-9cf6-4d75-822d-c29945alel
secret("c6e52419-227@8-4ch3-8bd4-ae7fdde
ethod("GET");
Url("https://30@30113-3657-4fh6-a7ef-98
QueryStringParam("name”, "value");
Header("Content-Type”, “"text/plain”);
published in other gnvs(except for Rel
ddHeader|(|"x-stage”, "publish_env_name™)
gody ( “demo™);

ion e) {

Trace();

ient client = null;

request.
Base signedRequest = Client.sign(reques
h : signedRequest.getAllHeaders()) {

put.println(h.getName() + ":" + h.getVa
brintln("---------nn "y
request.

sslContext = SSiCentexts.custon().leadT

pnsocketFactory sslSocketFactory = new .

1 |1 Java Application Alt+Shift+X, J

Run Configurations...

Step 5 On the Console tab page, view the running result.
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2.4 Go

Scenarios

Prerequisites

Figure 2-13 Response displayed if the calling is successful

'*| Problems |5\ Declaration B Conscle 2

=terminated= Main [Java Application] C:\Program Files\Javaijrel.8.0_191\bin\javaw.exe

HTTP/1.1

Date:Tue, 19 Mar 2019 @8:38:28 GMT
Content-Type:application/json
Transfer-Encoding:chunked
Connection:keep-alive

Server:api-gateway
X-Request-Id:844732a996756668d8d312ea362c9ea4)]
Access-Control-Allow-Origin:®

knngratulatians, sdk demo is runningl

--—-End

To use Go to call an API through app authentication, obtain the Go SDK, create a
new project, and then call the API by referring to the API calling example.

This section uses IntelliJ IDEA 2022.2.1 as an example.

e You have obtained API calling information. For details, see Preparation.

e You have installed Go 1.14 or a later version. If not, download the Go
installation package from the official Go website and install it.

e You have installed Intelli) IDEA 2022.2.1 or a later version. If not, download
the installation package from the official Intelli) IDEA website and install it.

e You have installed the Go plug-in on IntelliJ IDEA. If not, install the Go plug-in
according to Figure 2-14.
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Figure 2-14 Installing the Go plug-in

Plugins

g
q Go Template
<>¥

GoToTabs
GoogleTranslation
GoYacc Support

google-java-format

Plugins

> Version Control

v Build, Execution, Deployment 2 Godot Theme

?

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-go-sdk.zip package. The following table shows the
files decompressed from the package.

Name Description

core\escape.go SDK code

core\signer.go

demo.go Sample code

Creating a Project

Step 1 Start IntelliJ IDEA and choose File > New > Project.

In the displayed New Project dialog box, set Name to the name of the folder in
the SDK package, Location to the decompression path of the folder, Language to
Go, and click Create.
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Figure 2-15 Go

Environment:

Add sample code

Create

Step 2 View the directory structure shown in the following figure.

Figure 2-16 Directory structure of the new project go

:
license-go

B demogo

Iraries

hes and Consoles

Modify the parameters in sample code demo.go as required. For details about the
sample code, see API Calling Example.

--—-End
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API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

2.5 Python

Import the Go SDK (signer.go) to the project.
import "apig-sdk/go/core"

Generate a new signer and enter the AppKey and AppSecret.
s := core.Signer{

}

Key: os.Getenv("CLOUD_SDK_AK"),

Secret: os.Getenv("CLOUD_SDK_SK"),

Generate a new request, and specify the domain name, method, request URL,
query parameters, and body.

h

_ = http.NewRequest("POST", "http://c967a237-cd6c-470e-906f-

a8655461897e.apigw.exampleRegion.com/api?a=1&b=2",

ioutil. NopCloser(bytes.NewBuffer([]byte("foo=bar"))))

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
r.Header.Add("x-stage", "RELEASE")

Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:
s.Sign(r)

Access the APl and view the access result.

resp, err := http.DefaultClient.Do(r)
body, err := ioutil.ReadAll(resp.Body)

--—-End

Scenarios
To use Python to call an API through app authentication, obtain the Python SDK,
create a new project, and then call the API by referring to the API calling example.
This section uses IntelliJ IDEA 2018.3.5 as an example.
Prerequisites
e You have obtained API calling information. For details, see Preparation.
e You have installed Python 2.7.9 or 3.X. If not, download the Python
installation package from the official Python website and install it.
After Python is installed, run the pip command to install the requests library
in the CLI or Shell window.
pip install requests
(1] NOTE
If a certificate error occurs during the installation, download the get-pip.py file to
upgrade the pip environment, and try again.
e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download
the installation package from the official IntelliJ IDEA website and install it.
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e You have installed the Python plug-in on Intelli) IDEA. If not, install the
Python plug-in according to Figure 2-17.

Figure 2-17 Installing the Python plug-in

Settings ==
Qr Plugins Marketplace| 2 Installed Updates o ]
Appearance & Behavior
“ ] 3
Keymap
. Search Results (41)
Editor
BEED e Mictopython
Version Control Languages Framework integration
Euild, Execution, Deployment The Python plug-in provides Support for MicroPython
Languages & Frameworks smart editing for Python devices in Intelli) IDEA and
scripts. The feature set of the PyCharm. Features: Code
Tools

Live Coding in Python python-typing-adder
Code tools Code toals
Lets you run your Python README Using intellij to infer

Pythor

comment: 3|

e

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-python-sdk.zip package. The following table shows
the files decompressed from the package.

Name Description

apig_sdk\__init__.py SDK code

apig_sdk\signer.py

main.py Sample code
backend_signature.py Sample code for backend signing
licenses\license-requests Third-party license

Creating a Project
Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose Python and click Next.
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Figure 2-18 Python

New Project @
Maven Project SDK: | = Python 3.7.2 (D python.exe) MNew...
Gradle Additional Libraries and Framewarks:

8 Groovy [JEA Django
Grails [J€ Google App Engine (Python)
Application Forge [ 2. 5QL Support

© Go

“ Go Modules (vgo)

% Dep
‘s App Engine

Static Web
E Flash Template language:

_ Templates folder: templates
& Python

, Application name:
E Kotlin PE

Enable Django admin
= Empty Project 2

Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click
Finish.
Figure 2-19 Selecting the SDK directory after decompression
Mew Project @

Project name: | py‘thonl |

Project location: | D:\java\python

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.
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Figure 2-20 Directory structure of the new project python

v python
b Jidea
v ApiGateway-python-sdk-
v apig_sdk
_init__.py
signer.py
» licenses
main.py

test_signer.py
m Python.iml

Modify the parameters in sample code main.py as required. For details about the
sample code, see API Calling Example.

----End

API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Import apig_sdk to the project.

from apig_sdk import signer
import requests

Generate a new signer and enter the AppKey and AppSecret.

sig = signer.Signer()
sig.Key = "4f5f***100c"
sig.Secret = " xR

Generate a request, and specify the method, request URI, header, and request
body.

r = signer.HttpRequest("POST",
"https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?a=1",
{"x-stage": "RELEASE"},
"body")

Execute the following function to add the X-Sdk-Date and Authorization headers
for signing:

(11 NOTE

X-Sdk-Date is a request header parameter required for signing requests.
sig.Sign(r)

Access the API and view the access result.

resp = requests.request(r.method, r.scheme + "://
print(resp.status_code, resp.reason)
print(resp.content)

--—-End

+ r.host + r.uri, headers=r.headers, data=r.body)
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2.6 C#

Scenarios
To use C# to call an API through app authentication, obtain the C# SDK, open the
project file in the SDK, and then call the API by referring to the API calling
example.

Prerequisites

e  You have obtained API calling information. For details, see Preparation.
e You have installed Visual Studio 2019 version 16.8.4 or a later version. If not,

download it from the official Visual Studio website and install it.

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-csharp-sdk.zip package. The following table shows
the files decompressed from the package.

Name Description

apigateway-signature\Signer.cs SDK code

apigateway-signature\HttpEncoder.cs

sdk-request\Program.cs Sample code for signing requests
backend-signature\ Sample project for backend signing
csharp.sln Project file
licenses\license-referencesource Third-party license

Opening a Project

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:

e apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.
e backend-signature: Example of a backend service signature.

o sdk-request: Example of invoking the signature algorithm. Modify the
parameters as required. For details about the sample code, see API Calling
Example.
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API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Import the C# SDK to your project.
using APIGATEWAY_SDK;

Generate a new signer and enter the AppKey and AppSecret.

Signer signer = new Signer();
signer.Key = "4f5f**6100c";
signer.Secret = " e

Generate an HttpRequest, and specify the method, request URL, and body.

HttpRequest r = new HttpRequest("POST",

new Uri("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1?
query=value"));
rbody = "{\"a\":1}";

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
r.headers.Add("x-stage", "RELEASE");

Execute the following function to generate HttpWebRequest, and add the X-Sdk-
Date and Authorization headers for signing the request:
HttpWebRequest req = signer.Sign(r);

Access the APl and view the access result.

var writer = new StreamWriter(req.GetRequestStream());
writer.Write(r.body);

writer.Flush();

HttpWebResponse resp = (HttpWebResponse)req.GetResponse();
var reader = newStreamReader (resp.GetResponseStream());
Console.WriteLine(reader.ReadToEnd());

--—-End

2.7 JavaScript

Scenarios

To use JavaScript to call an API through app authentication, obtain the JavaScript
SDK, create a project, and then call the API by referring to the API calling example.

The JavaScript SDK can run in a Node.js or browser environment.

This section describes the procedure of using Intelli) IDEA 2018.3.5 to establish a
Node.js environment. It also provides examples of calling APIs using a browser.

Preparing the Environment

e You have obtained API calling information. For details, see Preparation.

e You have installed Node.js 15.10.0 or a later version. If not, download it from
the official Node.js website and install it.

e You have installed IntelliJ IDEA 2018.3.5 or a later version. If not, download it
from the official IntelliJ IDEA website and install it.

e You have installed the Node.js plug-in on Intelli) IDEA. If not, install the
Node.js plug-in according to Figure 2-21.
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Figure 2-21 Installing the Node.js plug-in
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Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring

to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-javascript-sdk.zip package. The following table

shows the files decompressed from the package.

Name Description

signer.js SDK code

node_demao.js Node.js sample code

demo.html Browser sample code

demo_require.html Browser sample code (loaded using
require)

test.js Test case

js\hmac-sha256.js Dependencies

licenses\license-crypto-js Third-party licenses

licenses\license-node

Creating a Project
Step 1 Start Intelli) IDEA and choose File > New > Project.

In the New Project dialog box, choose Static Web and click Next.
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Figure 2-22 Static Web
MNew Project @

El HTMLS Boilerplate

& React App
B Foundation

& Groovy
Grails

Application Forge
PP J B Bootstrap

“ Go Y Angular)s
“ Go Modules (vgo) Y Angular CLI
F Dep % React Native

s App Engine

(2 Nodejs and NPM
E Flash

. Web modules are used for developing Web applications using
‘ Kotlin technologies such as HTML/CSS, JavaScript, PHP and so on. They do
not support developing Java applications.
7 Python
= Empty Project 2

Il Cancel Help
Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.

Figure 2-23 Selecting the SDK directory of JavaScript after decompression
New Project (=3

Project name: |Ja\raScript |

Project location: | Di\java'JavaScript

¥ More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.
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Figure 2-24 Directory structure of the new project JavaScript
w [ JavaScript
» idea
w ApiGateway-javascript-sdk-2.0.0
> IE
> licenses
i dema.html
i demao_require.html
5= node_demojs
1 package-lock.jsan
5 signer.js
i tests
mJavaScriptiml
Il External Libraries

o Scratches and Consoles

e node_demao.js: Sample code in Node.js. Modify the parameters in the sample
code as required. For details about the sample code, see API Calling Example
(Node.js).

e demo.html: Browser sample code. Modify the parameters in the sample code
as required. For details about the sample code, see API Calling Example
(Browser).

Step 4 Click Edit Configurations.

Figure 2-25 Click Edit Configurations

Edit Configurations...

FH Save 'main’ Configuration

main

Step 5 Click + and select Node.js.
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Figure 2-26 Selecting Node.js
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Step 6 Set JavaScript file to node_demo.js and click OK.

Figure 2-27 Selecting node_demao.js

Run/Debug Configurations @
+ — B F i Name: | node_demo.js []share []Allow parallel run
~ (2 Node.js . . . .
. : Configuration Browser / Live Edit V8 Profiling Logs
oo
> Python Naode interpreter: Project node (D3| \node.exe) 10153 ~ || —

» F Templates

Nade parameters:

Working directory: D:\java\JavaScript\ApiGateway-javascript-sdk-2.0.0

JavaScript file: node_dema,js

Application parameters:

Environment variables:

--—-End

API Calling Example (Node.js)

Step 1 Import signer.js to your project.
var signer = require('./signer)
var http = require('http')
Step 2 Generate a new signer and enter the AppKey and AppSecret.

var sig = new signer.Signer()
sig.Key = "Af5f #+4 00"
sig.Secret = " #reea

Step 3 Generate a request, and specify the method, request URI, and request body.
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Step 4

Step 5

Step 6

var r = new signer.HttpRequest("POST", "c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com/app1?a=1");
rbody = '{"a":1}'

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
r.headers = { "x-stage":"RELEASE" }

Execute the following function to generate HTTP(s) request parameters, and add
the X-Sdk-Date and Authorization headers for signing the request:
var opts = sig.Sign(r)

Access the APl and view the access result. If you access the APl using HTTPS,
change http.request to https.request.

var req=http.request(opts, function(res){
console.log(res.statusCode)
res.on("data", function(chunk){
console.log(chunk.toString())
b
b
reg.on("error",function(err){
console.log(err.message)
b
req.write(r.body)
reqg.end()

--—-End

API Calling Example (Browser)

Step 1

Step 2

Before calling an APl with a browser, create an API that supports the OPTIONS
method by following the instructions in section "Enabling CORS" in the AP/
Gateway User Guide. When creating the API, enable CORS and add Access-
Control-Allow-* fields in the response header.

Import signer.js and dependencies to the HTML page.

<script src="js/hmac-sha256.js"></script>

<script src="js/moment.min.js"></script>

<script src="js/moment-timezone-with-data.min.js"></script>
<script src='signer.js'></script>

Sign the request and access the API.

var sig = new signer.Signer()
sig.Key = "4f5f****100c"
sig.Secret = " HrHeeR
var r= new signer.HttpRequest()
rhost = "c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com”
rmethod = "POST"
ruri = "/app1"
rbody ='{"a":1}
rquery = { "a™:"1","b":"2" }
rheaders = { "Content-Type":"application/json" }
var opts = sig.Sign(r)
var scheme = "https"
$.ajax({
type: opts.method,
data: req.body,
processData: false,
url: scheme + "://" + opts.hostname + opts.path,
headers: opts.headers,
success: function (data) {
$('#status').html('200')
$('#recv').html(data)
}
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2.8 PHP

error: function (resp) {
if (resp.readyState === 4) {
$('#status').html(resp.status)
$('#recv').html(resp.responseText)
}else {
$('#status').html(resp.state())
}
I
timeout: 1000
b

--—-End

Scenarios
To use PHP to call an API through app authentication, obtain the PHP SDK, create
a new project, and then call the API by referring to the API calling example.
This section uses IntelliJ IDEA 2018.3.5 as an example.
Prerequisites
e You have obtained API calling information. For details, see Preparation.
e You have installed IntelliJ IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli) IDEA website and install it.
e You have installed PHP 8.0.3 or a later version. If not, download it from the
official PHP website and install it.
e Copy the php.ini-production file from the PHP installation directory to the
C:\windows\ directory, rename the file as php.ini, and then add the following
lines to the file:
extension_dir = "PHP installation directory/ext"
extension=openssl
extension=curl
e You have installed the PHP plug-in on Intelli) IDEA. If not, install the PHP
plug-in according to Figure 2-28.
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Figure 2-28 Installing the PHP plug-in
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Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-php-sdk.zip package. The following table shows the
files decompressed from the package.

Name Description
signer.php SDK code
index.php Sample code

Creating a Project

Step 1 Start IDEA and choose File > New > Project.
On the displayed New Project page, choose PHP and click Next.
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Figure 2-29 PHP
Bl New Project @

& Groovy I} PHP Empty Project

Grails @ Composer Project

Application Forge
o Go
“ Go Modules (vgo)
& Dep
% App Engine

Static Web
(2 Nodejs and NPM

E Flash

PHP
l | Create empty project for PHP
Kotlin
Pythan
= Empty Project

Cancel Help

Step 2 Click ..., select the directory where the SDK is decompressed, and click Finish.

Figure 2-30 Selecting the SDK directory of PHP after decompression
New Project @

Project name: | php

Project location: | D:\java\php |

b More Settings

Previous Cancel Help

Step 3 View the directory structure shown in the following figure.
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Figure 2-31 Directory structure of the new project php
v [Lphp
¥ idea
v ApiGateway-php-sdl-
o index.php
ahs Signer.php
m Php.iml
» External Libraries

Scratches and Consoles

Modify the parameters in sample code signer.php as required. For details about
the sample code, see API Calling Example.

--—-End

API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

2.9 C++

Scenarios

Import the PHP SDK to your code.

require 'signer.php’;

Generate a new signer and enter the AppKey and AppSecret.

$signer = new Signer();
$signer->Key = '4f5F***100¢;
$signer->Secret = " A

Generate a new request and specify the method, request URL, and body. (The
body should contain the actual request content.)

$req = new Request('GET', "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/
app1?a=1");
$req->body = ";

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
$req->headers = array(
'x-stage' => 'RELEASE',
)i
Execute the following function to generate a $curl context variable.
$curl = $signer->Sign($req);

Access the APl and view the access result.

$response = curl_exec($curl);

echo curl_getinfo($curl, CURLINFO_HTTP_CODE);
echo $response;

curl_close($curl);

--—-End

To use C++ to call an API through App authentication, obtain the C++ SDK, and
then call the API by referring to the API calling example.
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Prerequisites

You have obtained API calling information. For details, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.

apt-get install libcurl4-openssl-dev

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-cpp-sdk.zip package. The following table shows the
files decompressed from the package.

Name Description
hasher.cpp SDK code
hasher.h

header.h

RequestParams.cpp

RequestParams.h

signer.cpp

signer.h

Makefile Makefile file
main.cpp Sample code

API Calling Example

Step 1

Step 2

Step 3

Step 4

Add the following references to main.cpp:

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.h"

Generate a new signer and enter the AppKey and AppSecret.

Signer signer("4f5f****100c", "******");

Generate a new RequestParams request, and specify the method, domain name,
request URI, query strings, and request body.

RequestParams* request = new RequestParams("POST", "c967a237-cd6c-470e-906f-
a8655461897e.apigw.exampleRegion.com", "/app1",
"Action=ListUsers&Version=2010-05-08", "demo");

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
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Step 5

Step 6

request->addHeader("x-stage", "RELEASE");

Execute the following function to add the generated headers to the request

variable.
signer.createSignature(request);

Use the curl library to access the API and view the access result.

static size_t

WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)

{

}

size_t realsize = size * nmemb;
struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);

if (mem->memory == NULL) {
/* out of memory! */
printf("not enough memory (realloc returned NULL)\n");
return O;

}
memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;

mem->memory[mem->size] = 0;

return realsize;

//send http request using curl library
int perform_request(RequestParams* request)

{

CURL *curl;

CURLcode res;

struct MemoryStruct resp_header;
resp_header.memory = (char*)malloc(1);
resp_header.size = 0;

struct MemoryStruct resp_body;
resp_body.memory = (char*)malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, request->getMethod().c_str());
std::string url = "http://" + request->getHost() + request->getUri() + "?" + request->getQueryParams();

curl_easy_setopt(curl, CURLOPT_URL, url.c_str());
struct curl_slist *chunk = NULL;
std::set<Header>:iterator it;

for (auto header : *request->getHeaders()) {

std::string headerEntry = header.getKey() + ": " + header.getValue();

printf("%s\n", headerEntry.c_str());

chunk = curl_slist_append(chunk, headerEntry.c_str());
}
printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);

curl_easy_setopt(curl, CURLOPT_COPYPOSTFIELDS, request->getPayload().c_str());

curl_easy_setopt(curl, CURLOPT_NOBODY, OL);

curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);

//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res = CURLE_OK) {

fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));

else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
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printf(resp_body.memory);
}
free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);
curl_global_cleanup();

return O;

}

Step 7 Run the make command to obtain a main executable file, execute the file, and
then view the execution result.

--—-End

210 C

Scenarios

To use C to call an API through app authentication, obtain the C SDK, and then
call the API by referring to the API calling example.

Prerequisites

1.  You have obtained API calling information. For details, see Preparation.

2. Install the OpenSSL library.
apt-get install libssl-dev

3. Install the curl library.

apt-get install libcurl4-openssl-dev

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-c-sdk.zip package. The following table shows the
files decompressed from the package.

Name Description

signer_common.c SDK code

signer_common.h

signer.c
signer.h
Makefile Makefile file
main.c Sample code
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API Calling Example

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Add the following references to main.c:

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <curl/curl.h>
#include "signer.n"

Generate a sig_params_t variable, and enter the AppKey and AppSecret.

sig_params_t params;
sig_params_init(&params);

sig_str_t app_key = sig_str("4/5f***100c");
sig_str_t app_secret = sig_str(" ****"');
params.key = app_key;

params.secret = app_secret;

Specify the method, domain name, request URI, query strings, and request body.

sig_str_t host = sig_str("c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com");
sig_str_t method = sig_str("GET");

sig_str_t uri = sig_str("/app1");

sig_str_t query_str = sig_str("a=1&b=2");

sig_str_t payload = sig_str("");

params.host = host;

params.method = method;

params.uri = uri;

params.query_str = query_str;

params.payload = payload;

Add the x-stage header to the request to specify an environment name. Add other
headers to be signed as necessary.
sig_headers_add(&params.headers, "x-stage", "RELEASE");

Execute the following function to add the generated headers to the request
variable.
sig_sign(&params);

Use the curl library to access the API and view the access result.

static size_t
WriteMemoryCallback(void *contents, size_t size, size_t nmemb, void *userp)
{

size_t realsize = size * nmemb;

struct MemoryStruct *mem = (struct MemoryStruct *)userp;

mem->memory = (char*)realloc(mem->memory, mem->size + realsize + 1);
if (mem->memory == NULL) {

/* out of memory! */

printf("not enough memory (realloc returned NULL)\n");

return O;

}

memcpy (&(mem->memory[mem->size]), contents, realsize);
mem->size += realsize;
mem->memory[mem->size] = 0;

return realsize;

}

//send http request using curl library
int perform_request(RequestParams* request)
{
CURL *curl;
CURLcode res;
struct MemoryStruct resp_header;
resp_header.memory = malloc(1);
resp_header.size = 0;
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struct MemoryStruct resp_body;
resp_body.memory = malloc(1);
resp_body.size = 0;

curl_global_init(CURL_GLOBAL_ALL);
curl = curl_easy_init();

curl_easy_setopt(curl, CURLOPT_CUSTOMREQUEST, params.method.data);
char url[1024];
sig_snprintf(url, 1024, "http://%V%V?%V", &params.host, &params.uri, &params.query_str);
curl_easy_setopt(curl, CURLOPT_URL, url);
struct curl_slist *chunk = NULL;
for (inti = 0; i < params.headers.len; i++) {
char header[1024];
sig_snprintf(header, 1024, "%V: %V", &params.headers.data[i]l.name, &params.headers.datali].value);
printf("%s\n", header);
chunk = curl_slist_append(chunk, header);

printf("------------- \n");
curl_easy_setopt(curl, CURLOPT_HTTPHEADER, chunk);
curl_easy_setopt(curl, CURLOPT_POSTFIELDS, params.payload.data);
curl_easy_setopt(curl, CURLOPT_NOBODY, OL);
curl_easy_setopt(curl, CURLOPT_WRITEFUNCTION, WriteMemoryCallback);
curl_easy_setopt(curl, CURLOPT_HEADERDATA, (void *)&resp_header);
curl_easy_setopt(curl, CURLOPT_WRITEDATA, (void *)&resp_body);
//curl_easy_setopt(curl, CURLOPT_VERBOSE, 1L);
res = curl_easy_perform(curl);
if (res !'= CURLE_OK) {

fprintf(stderr, "curl_easy_perform() failed: %s\n", curl_easy_strerror(res));

else {
long status;
curl_easy_getinfo(curl, CURLINFO_HTTP_CODE, &status);
printf("status %d\n", status);
printf(resp_header.memory);
printf(resp_body.memory);

free(resp_header.memory);
free(resp_body.memory);
curl_easy_cleanup(curl);
curl_global_cleanup();
//free signature params
sig_params_free(&params);

return O;

}

Step 7 Run the make command to obtain a main executable file, execute the file, and
then view the execution result.

--—-End

2.11 Android

Scenarios
To use Android to call an API through app authentication, obtain the Android SDK,
create a new project, and then call the API by referring to the API calling example.

Prerequisites
e You have obtained API calling information. For details, see Preparation.
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e You have installed Android Studio 4.1.2 or a later version. If not, download it
from the official Android Studio website and install it.

Obtaining the SDK

Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.

Then obtain the ApiGateway-android-sdk.zip package. The following table shows
the files decompressed from the package.

Name Description

app\ Android project code
gradle\ Gradle files

build.gradle Gradle configuration files

gradle.properties

settings.gradle

gradlew Gradle Wrapper scripts

gradlew.bat

Opening a Project
Step 1 Start the Android Studio and choose File > Open.
Select the directory where the SDK is decompressed.

Step 2 View the directory structure of the project shown in the following figure.
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Figure 2-32 Project directory structure

e app
> manifests
W java
hd com.testappsignature
£ MainActivity
> com.test.appsignature (androidTest)
? com.testappsignature (test)
W res
> drawable
w layout
v, activity_main.eml
> mipmap
» values

Gradle Scripts
# build.gradle (Project: android)
# build.gradle (Module: app)

gradle.properties (Global Properties)

gradle.properties (Froject Properties
*} settings.gradle (Project Settings)
local properties (SDK Location)

--—-End

API Calling Example

Step 1

Step 2

Step 3

Add required JAR files to the app/libs directory of the Android project. The
following JAR files must be included:

e java-sdk-core-x.x.x.jar
e commons-logging-1.2.jar
e joda-time-2.10.jar

Add dependencies of the okhttp library to the build.gradle file.

Add implementation 'com.squareup.okhttp3:0khttp:3.14.2' in the dependencies
field of the build.gradle file.

dependencies {

implementation 'com.squareup.okhttp3:okhttp:3.14.3'
}

Create a request, enter an AppKey and AppSecret, and specify the domain name,
method, request URI, and body.

Request request = new Request();

try {
request.setKey ("475****100c");
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Step 4

2.12 curl

Scenarios

Prerequisites

request.setSecrect(" *****);
request.setMethod ("POST");
request.setUrl("https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/app1");
request.addQueryStringParam("name", "value");
request.addHeader("Content-Type", "text/plain");
request.setBody("demo");
} catch (Exception e) {
e.printStackTrace();
return;

}

Sign the request to generate an okhttp3.Request object for API access.

okhttp3.Request signedRequest = Client.signOkhttp(request);
OkHttpClient client = new OkHttpClient.Builder().build();
Response response = client.newCall(signedRequest).execute();

--—-End

To use the curl command to call an API through app authentication, download the
JavaScript SDK to generate the curl command, and copy the command to the CLI
to call the API.

You have obtained API calling information. For details, see Preparation.

API Calling Example

Step 1 Use the JavaScript SDK to generate the curl command.
Log in to the APIG console, and download the SDK on the SDKs page by referring
to section "SDKs" in the AP/ Gateway User Guide.
Open demo.html in a browser. The following figure shows the demo page.
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Apigateway Signature Test

Key

071fe245-9cf6-4d75-822d-c29945a1e06a

Secret
Method Url

GET s 30030113-3657-4fb6-a7ef-90764239b038
Headers

{"Content-Type":"application/json"}
Body

e

curl -X GET "http://30030113-3657-4fb6-a7ef-90764239b03!
d.com/" -H "X-Sdk-Date: 20190731T065514Z" -H "host: 30030113-3657-4fb6-a7ef-9076423

Note: accessing the API from browser requires support for CORS
200
Congratulations, sdk dema is running

Step 2 Specify the key, secret, method, protocol, domain name, and URL. For example:

Key=415f**100c

Secret=***#**

Method=POST
Url=https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com

Step 3 Specify query and header parameters in JSON format, and set the request body.

Step 4 Click Send request to generate a curl command. Copy the curl command to the
CLI to access the API.

$ curl -X POST "https://c967a237-cd6c-470e-906f-a8655461897e.apigw.exampleRegion.com/" -H "X-Sdk-
Date: 20180530T115847Z" -H "Authorization: SDK-HMAC-SHA256 Access=071fe245-9cf6-4d75-822d-
€29945a1e06a, SignedHeaders=host;x-sdk-date, Signature=9e5314bd156d517****dd3e5765fdde4" -d ""
Congratulations, sdk demo is running

(1 NOTE

The curl command generated using an SDK does not meet the format requirements of
Windows. Please run the curl command in Git Bash.

--—-End
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Calling APIs Through IAM
Authentication

3.1 Token Authentication

Scenarios

To call APIs using a token, add the token to the X-Auth-Token header in API
requests.

(11 NOTE

You can use either of the following authentication methods to call APIs:
e Token authentication: Requests are authenticated using a token.

e AK/SK authentication: Requests are encrypted using an access key ID (AK) and a secret
access key (SK).

API Calling Example

1. Obtain a token and set it as an environment variable for authenticating the
calling of other APIs.

a. Obtain a token. An example request is as follows:
curl -X POST https://{iam_endpoint}/v3/auth/tokens -H 'content-type: application/json' -d '{
"auth": {
"identity": {

"methods": [
"password"

]I

"password": {
"user": {
"name": "{user_namej}",

"domain": {

}I

"password": "{password}'

}
h?
"scope": {

"project™: {
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"id": "{project_id}"
}
}

}
} -vk

Modify the parameters in the preceding command according to the
following description. For details, see the API forObtaining a User Token
in the /dentity and Access Management APl Reference.

®  Obtain the flam_endpoint} from Regions and Endpoints.

" Replace {user name} and {password} respectively with the
username and password of the IAM server.

= {project id} The project ID. On the management console, hover the
mouse pointer over the username in the upper right corner, choose
My Credentials from the drop-down list, and then view the project
ID on the displayed page.

The token value is the X-Subject-Token value in the response header as
shown below:
Figure 3-1 Obtaining the X-Subject-Token response header

connection — keep-alive

content-type — application/json

date — Mon, 05 Nov 2018 09:55:39 GM
server — Web Server
strict-transport-security — max-age=31536000; includeSubdomains
transfer-encoding — chunked

via = proxy A

x-content-type-options — nosniff

x-download-options — noopen

x-frame-options - SAMEORIGIN

¥-iam-trace-id 77:5::"_5.3:.351 3d440f7854f1cd

x-subject-token

b. Run the following command to set an environment variable for passing
the token:

export Token={X-Subject-Token}
X-Subject-Token is the token obtained in 1.a. Example:
export Token=MIIDkg****BZQMEAgEwg

2. To call an API, obtain the domain name, request method, and URL by
referring to Preparation, add X-Auth-Token to the request header, and set
the value of X-Auth-Token to the token obtained in 1. Set the parameters
based on the site requirements.
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curl -X Request_method Domain name+URL -H "x-auth-token: $Token" -vk

3.2 AK/SK Authentication

This section describes how to use AK and SK to sign requests.

(1 NOTE

e AK: access key ID, which is a unique identifier used in conjunction with a secret access
key to sign requests cryptographically.

e SK: secret access key used in conjunction with an AK to sign requests cryptographically.
It identifies a request sender and prevents the request from being modified.

Generating an AK and SK Pair

If an AK/SK pair has already been generated, skip this step. Find the downloaded
AK/SK file, which is usually named credentials.csv.

As shown in the following figure, the file contains the username, access key ID,
and secret access key.

Figure 3-2 Content of the credential.csv file

4 E C
1 |User Name Access Key Id Gecret Access Eevy
2 NN NS SETEETINEVEES | zul TS eRRNT Teenle el ¥ hhSzsdaCwf4

Perform the following procedure to generate an AK/SK pair:

1. Log in to the console.

2. Hover the mouse pointer over the username and choose My Credentials
from the drop-down list.

3. Click the Access Keys tab.
4. Click Create Access Key.

5. Enter the verification code or login password as prompted, and click OK to
download the access key. Keep the access key secure.

Generating a Signature

Generate a signature in the same way as in App authentication mode. Replace
AppKey with AK and replace AppSecret with SK to complete the signing and
request processing. You can sign requests to access APIs by using Java, Go,
Python, C#, JavaScript, PHP, C++, C, and Android.
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NOTICE

The local time on the client must be synchronized with the clock server to avoid a
large error in the value of the X-Sdk-Date request header.

APIG (API Management) checks the time format and compares the time with the
time when APIG (APl Management) receives the request. If the time difference
exceeds 15 minutes, APIG will reject the request.
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Creating a Function for Frontend
Custom Authentication

Scenarios

API requests can be authenticated using a custom authorizer. You need to create a
FunctionGraph function for frontend custom authentication and define the
required authentication information in the function. The function then serves as a
custom authentication backend to authenticate requests for the API.

This section describes how to encapsulate a function into a "custom authorizer"
and the important operations that need to be noted.

Figure 4-1 Schematic diagram of frontend custom authentication

APl Gatewvay Eackend Services

Reguests

’i‘ Frontend requests
@ L1 —
[]

Security authentication ECS
UsersfApps :
Custom

‘ 403

App

b

B

Internet

The following figure shows the process of calling APIs using custom
authentication.
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Figure 4-2 Calling APIs by using custom authentication

Start
Procedurs Create a function.
Create a function to use it as Create a function in N
the backend for custom FunctionGraph —— =

authentication.

Test the function.

Create a custom authorizer with
the FunctionGraph function.

Set the Custom authentication
mode to authenticate requests

far the AP
Fublish the AFI.
Call the API.
End
{1 NOTE

FunctionGraph is required for custom authorizers. If FunctionGraph is unavailable in the
selected region, custom authorizers are not supported.

Procedure

Step 1 Create a function in FunctionGraph.

The function code must meet the following requirements (Python 2.7 is used as an
example):

e The function code has defined three types of request parameters in the
following formats:

- Header parameters: event["headers"][" Parameter name"]
- Query parameters: event["queryStringParameters"][" Parameter name"]
- Custom user data: event["user_data"]

e The three types of request parameters obtained by the function are mapped
to the custom authentication parameters defined in APIG.

- Header parameter: Corresponds to the identity source specified in Header
for custom authentication. The parameter value is transferred when the
API that uses custom authentication is called.

- Query parameter: Corresponds to the identity source specified in Query
for custom authentication. The parameter value is transferred when the
API that uses custom authentication is called.
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- Custom user data: Corresponds to the user data for custom
authentication. The parameter value is specified when the custom
authentication system is created.

e The response of the function cannot be greater than 1 MB and must be

displayed in the following format:

{
"statusCode":200,

- The status field is mandatory and is used to identify the authentication
result. The authentication result can only be allow or deny. allow
indicates that the authentication is successful, and deny indicates that
the authentication fails.

- The context field is optional. It can be key-value pairs, but the key value
cannot be a JSON object or an array.

The context field contains custom user data. After successful
authentication, the user data is mapped to the backend parameters. The
parameter name in context is case-sensitive and must be the same as
the system parameter name. The parameter name must start with a
letter and can contain 1 to 32 characters, including letters, digits, hyphens
(-), and underscores ().

After successful frontend authentication, the value abc of user in context
is mapped to the test parameter in the Header location of backend
requests.

Example header parameters:

-*- coding:utf-8 -*-
import json
def handler(event, context):
if event["headers"].get("test")=="abc":
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"allow",
"context":{
"user":"abcd"
}
b
}
else:
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"deny",
b
}

return json.dumps(resp)

Example query parameters:

# -*- coding:utf-8 -*-
import json
def handler(event, context):
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if event["queryStringParameters"].get("test")=="abc"
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"allow",
"context":{
"user":"abcd"
}
b
}
else:
resp = {
'statusCode': 200,
'body": json.dumps({
"status":"deny",
b
}

return json.dumps(resp)

Example user data:

-*- coding:utf-8 -*-
import json
def handler(event, context):
if event.get("user_data")=="'abc"
resp = {
'statusCode": 200,
'body": json.dumps({
"status":"allow",
"context":{
"user":"abcd"
}
b
}
else:
resp = {
'statusCode": 200,
'body": json.dumps({
"status":"deny",
b
}

return json.dumps(resp)

Step 2 Test the function. In the Configure Test Event dialog box, select apig-event-
template, edit the test event, and click Save. Then click Test.

If the execution result is Success, the test is successful.

Next, you need to go to the APIG console to create a frontend custom authorizer.
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v Detalls

Function Output

('stetusCode” 200 "body" "{V'status\": \'deny\'}'}

Surmary

Memory Confiured: 126 MB

FequestID: SbAThe7d-4683-451e-853F53faf0070b4
Memory Used 2B914M8

Execution Duration: ~ 3,689 ms
Eilled Duration 100ms

Log Output

2019-89-86 16:42:10.883+08:00 Start invoke raquest 'Sha7he7d-4683-45fe-853f-5:faffea7eba’, version: latest
25t ' Sha7be7d-4683-45fe-853f-S3faffoR76b4', duration: 3.63

2019-8¢-86 16:42:10.887+08:00 Finish invok:
9ns, billing duration: 10@ns, nemory used: 43.77718.

--—-End

Follow-Up Operations

Create a custom authorizer for frontend authentication on the APIG console. For
details, see section "Create a custom authorizer" in the AP/ Gateway User Guide.

2023-12-19

54



API Gateway 5 Creating a Function for Backend Custom
Developer Guide Authentication

Creating a Function for Backend Custom
Authentication

Scenarios

To protect backend services, you can use multiple external authentication systems
by configuring one authentication mechanism. You need to create a
FunctionGraph function for backend custom authentication and define the
required authentication information in the function. The function then serves as a
custom authentication backend to authenticate requests forwarded by APIG.

Figure 5-1 Schematic diagram of backend custom authentication

ARl Gateway Eackend Services

@l = =~

Users/Apps Backend authentication

] Custom

Signature key

2

Internet

The following figure shows the process of calling APIs using custom
authentication.
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Procedure

Figure 5-2 Calling APIs by using custom authentication

Start

Procedure Create a function.

Create a function to use it as Create a function in I~ e

the backend for custom . =
-1~
authentication. FunctionGraph. 1

Test the function.

Create a custom authorizer with

the FunctionGraph function. Create a custom authorizer.

Set the Custom authentication Create an AP| and specify the

mode to authenticate requests P
for the APl Custom authentication mode.

Debug the AP

Publish the API.

Call the API.

(1 NOTE

FunctionGraph is required for custom authorizers. If FunctionGraph is unavailable in the
selected region, custom authorizers are not supported.

Step 1 Create a function in FunctionGraph.

The function code must meet the following requirements (Python 2.7 is used as an
example):

e The custom user data contained in the function code must be in the following
format: event["user_data"].

e The custom user data corresponds to the user data defined for the custom
authorizer. You can define the user data in any format.

e The response of the function cannot be greater than 1 MB and must be
displayed in the following format:

"statusCode":200,
"body": "{\"status\": \"allow\", \"context\": {\"user\": \"abc\"}}"

The body field is a character string, which is JSON-decoded as follows:
{

"status": "allow/deny",
"context": {

"user": "abc"
}

}
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- The status field is mandatory and is used to identify the authentication
result. The authentication result can only be allow or deny. allow
indicates that the authentication is successful, and deny indicates that
the authentication fails.

- The context field is optional. It can be key-value pairs, but the key value
cannot be a JSON object or an array.

The context field contains custom user data. After successful
authentication, the user data is mapped to the backend parameters. The
parameter name in context is case-sensitive and must be the same as
the system parameter name. The parameter name in context must start
with a letter and contain 1 to 32 characters, including uppercase letters,
lowercase letters, digits, underscores (_), and hyphens (-).

After successful backend authentication, the value abc of user in context
is mapped to the test parameter in the Header location of backend
requests and passed to the backend service.

Example user data:

-*- coding:utf-8 -*-

import json

import base64

def handler(event, context):
exampleuserdata=base64.b64encode(event["user_data"])
resp = {

'statusCode': 200,

'body": json.dumps({
"status":"allow",
"context":{

"user":exampleuserdata
}
b
}

return json.dumps(resp)

Step 2 Test the function. In the Configure Test Event dialog box, select blank-template,
and set the following test event:
{"user_data": "123"}

Click Save. Then click Test.
If the execution result is Success, the test is successful.

Next, you need to go to the APIG console to create a backend custom authorizer.
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v Detalls

Function Output

{'body":"\'status\: Vallow\', eantext\": {Vtoken!": 'MTZ\)}, "statusCode" 200}

Summary

Memory Configured: 126 MB

FequestID: eGcff7-2a2e-4aT-571-Bhe30eT8ez
Memory Used 4621518

Execution Duration: 1532 ms
Eilled Duration 160ms

Log Output

2019-89-66 11:34:02.336+08:00 Start invoke request 'edcfdfe-dade-4daj-a571-8be30e7892ea’, version: latast
2019-00-66 11:34:02.338+08:00 Fini quest ' e9cfdfe7-2a2e-4da7-a571-8he30e7892ea’, duration: 1.53
s, billing duration: 108ms, menory used: 46.21518.

--—-End

Follow-Up Operations

Create a custom authorizer for backend authentication on the APIG console. For
details, see section "Create a custom authorizer" in the AP/ Gateway User Guide.
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Creating Signatures for Backend
Requests

6.1 Pre-signature Preparations

6.2 Java

Scenarios

Prerequisites

Obtaining signature key information:

On the APIG instance console, choose APl Management > API Policies > Policies,
click the signature key name to go to the details page, and view the key and
secret in the Policy Content area.

To use Java to sign backend requests, obtain the Java SDK, import the project, and
verify the backend signature by referring to the example provided in this section.

This section uses IntelliJ IDEA 2018.3.5 as an example.

You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Signature Keys" in the AP/
Gateway User Guide.

You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

In the APIG console, download the SDK on the SDKs page by referring to
section "SDKs" in the AP/ Gateway User Guide.

You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official IntelliJ IDEA website and install it.

You have installed Java Development Kit (JDK) 1.8.111 or a later version. If
not, download JDK from the official Oracle website and install it. IDK 17 or
later is not supported.
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Importing a Project

Step 1 Open Intelli) IDEA, choose File > New > Project from Existing Sources, select the
apigateway-backend-signature-demo\pom.xml file, and click OK.

Figure 6-1 Select File or Directory to Import

Select File or Directory to Import >

Select directory with existing sources,

Eclipse project (.project) or classpath (.classpath] file,
Maven project file (pom.xml),

End/Bndtools workspace (workspace/cnf),

Gradle build script (*.gradle],

Flash Builder project file (.project, *.fxp, *.fxpl).

f O g X G % Hide path
GpiGateway-sdki\apigateway-backend-signature-demol\pom.xml| | &
> ApiGateway-android-sdk-1.0.0

v apigateway-backend-signature-demo
> idea
> libs
b src

pom.xml

E"Eg and drop a file into the space above to qu Ry oate it in the tree
o

Step 2 Retain the default settings, click Next for the following four steps, and then click
Finish.

Step 3 On the Maven tab page on the right, double-click compile to compile the file.
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Figure 6-2 Compiling the project

Mawven o —
S R i+ m M ® | F

~ |, backend-signature
w Lifecycle

clean

validate

2
test 1

package

verify

install

site

deploy
» Plugins

» [iiDependencies

aseqeyed ([

UoREpI|Es UBRE 5 |uanew 3 | MBS

If the message "BUILD SUCCESS" is displayed, the compilation is successful.

Run: backend-signature [compile]
[I1F0]

[IVFO] Cepying 1 resource
[INFO] Copying O resource
[I1FO]

I 4l

[INFO] --- maven-resources—plugin:3.1. 0 resowrces (default-resources) @ backend-signature ——-

[INFO] Using "UTF-8 encoding to copy filtered resources.

[IWFO] -—- maven—compiler-plugin:3. 8 0:compile (default-compile) @ backend-signature ——-
[IVFO] Nothing to compile - all classes are up to date

[11F0]
[INFO]|EUILD SUCCESS

[I1FO]
[INFO] Tetal time: 2.688 s

}* [IVFO] Finished at: 2019-03-11T18:41:09405:00
[INFO] Final Memory: Z21M/309M

[IWFO]

Process finished with exit code O

Step 4 Right-click BackendSignatureApplication and choose Run.
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Figure 6-3 Running the BackendSignatureApplication service

v apigateway-backend-signature-demo 1 packa
> idea i
> Dulibs — :
v src 2 Cut Ctrl+X
v main B Copy Ctrl+C
w java Caopy Path Ctrl+Shift+C
v corr apigat  Copy Reference Ctrl+Alt+Shift+C
€ ApigatewaySigr [ Paste Ctrl+V
t&,BackendSignatl # Jump to Source E4
& HelloController Find Usages Alt+F7
£ ReguestWrapp Analyze ¥
» resources Refactor 3
4 farast ;5-3-“ Python Compiled Files
pom.xml Add to Favorites ;
¥ |l External Libraries .
s Seratches and Consoles Browse Type Hierarchy Ctrl+H
Reformat Code Cirl+Alt+L
Optimize Imports Cirl +Alt+0
Delete... Delete

Build Module 'apigateway-backend-signature-demo’
Recompile "..ureApplication.java’ Ctrl+Shift+F9

Run 'BackendSignatureAppl..' Ctrl+Shift+F10
¥ Debug 'BackendSignatureAppl...
U} Run 'BackendSignatureAppl...' with Coverage

o Create 'BackendSignatureAppl...'...

Modify the parameters in sample code ApigatewaySignatureFilter.java as
required. For details about the sample code, see Backend Signature Verification
Example.

--—-End

Backend Signature Verification Example

This example demonstrates how to build a Spring boot-based server as the
backend of an APl and implement a filter to verify the signature of requests sent
from APIG (APl Management).

(11 NOTE

Signature information is added to requests sent to access the backend of an API only after
a signature key is bound to the API.

Step 1 Compile a controller that matches all request paths and methods and set the
return body to Hello World!

// HelloControllerjava
@RestController

@EnableAutoConfiguration
public class HelloController {

@RequestMapping("/*")
private String index() {

2023-12-19 62



API Gateway
Developer Guide

6 Creating Signatures for Backend Requests

Step 2

Step 3

Step 4

return "Hello World!";
}
}

Compile a filter that matches all request paths and methods, and put the
signature key and secret in a Map.
// ApigatewaySignatureFilter.java

@Component
@WebfFilter(filterName = "ApigatewaySignatureFilter", urlPatterns = "/*")
public class ApigatewaySignatureFilter implements Filter {
private static Map<String, String> secrets = new HashMap<>();
static {
secrets.put("signature_key1", "signature_secret1");
secrets.put("signature_key2", "signature_secret2");

}

@Override
public void init(FilterConfig filterConfig) throws ServletException {
}

@Override
public void doFilter(ServletRequest servletRequest, ServletResponse servletResponse, FilterChain chain) {
//Signature verification code

-
}

To ensure that the body can be read in the filter and controller, wrap the request
and send it to the filter and controller. The doFilter function is used for signature
verification. For the implementation of wrapper classes, see RequestWrapper.java.
RequestWrapper request = new RequestWrapper((HttpServletRequest) servletRequest);

Use a regular expression to parse the Authorization header to obtain signingKey
and signedHeaders.

private static final Pattern authorizationPattern = Pattern.compile("SDK-HMAC-SHA256\\s+Access=([A,]+),\
\s?SignedHeaders=([A,]+),\\s?Signature=(\\w+)");

String authorization = request.getHeader("Authorization");

if (authorization == null || authorization.length() == 0) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization not found.");
return;

}

Matcher m = authorizationPattern.matcher(authorization);

if (!m.find()) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Authorization format incorrect.");
return;

}

String signingKey = m.group(1);

String signingSecret = secrets.get(signingKey);

if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}

String[] signedHeaders = m.group(2).split(";");

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date
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Step 5

Step 6

Step 7

Find signingSecret based on signingKey. If sighingKey does not exist, the
authentication failed.
String signingSecret = secrets.get(signingKey);
if (signingSecret == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signing key not found.");
return;

}

Create a request, and add the method, URL, query, and signedHeaders headers to
the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

Request apiRequest = new DefaultRequest();
apiRequest.setHttpMethod (HttpMethodName.valueOf(request.getMethod()));
String url = request.getRequestURL().toString();
String queryString = request.getQueryString();
try {
apiRequest.setEndpoint((new URL(url)).toURI());
Map<String, String> parametersmap = new HashMap<>();
if (null != queryString && !"".equals(queryString)) {
String[] parameterarray = queryString.split("&");
for (String p : parameterarray) {
String[] p_split = p.split("=", 2);
String key = p_split[0];
String value = "";
if (p_split.length >=2) {
value = p_split[1];
}
parametersmap.put(URLDecoder.decode(key, "UTF-8"), URLDecoder.decode(value, "UTF-8"));
}

apiRequest.setParameters(parametersmap); //set query

} catch (URISyntaxException e) {
e.printStackTrace();

}

boolean needbody = true;
String dateHeader = null;
for (inti = 0; i < signedHeaders.length; i++) {
String headerValue = request.getHeader(signedHeaders[i]);
if (headerValue == null || headerValue.length() == 0) {
((HttpServletResponse) response).sendError(HttpServletResponse.SC_UNAUTHORIZED, "signed
header" + signedHeaders[i] + " not found.");
} else {
apiRequest.addHeader(signedHeaders[i], headerValue);//set header
if (signedHeaders[i].toLowerCase().equals("x-sdk-content-sha256") &&
headerValue.equals("UNSIGNED-PAYLOAD")) {
needbody = false;
}
if (signedHeaders[i].toLowerCase().equals("x-sdk-date")) {
dateHeader = headerValue;
}
}
}

if (needbody) {
apiRequest.setContent(new ByteArraylnputStream(request.getBody())); //set body

Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

private static final DateTimeFormatter timeFormatter =
DateTimeFormat.forPattern("yyyyMMdd'T'HHmmss'Z'").withZoneUTC();

2023-12-19

64



API Gateway
Developer Guide

6 Creating Signatures for Backend Requests

Step 8

Step 9

if (dateHeader == null) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Header x-sdk-date not found.");
return;

}

long date = timeFormatter.parseMillis(dateHeader);

long duration = Math.abs(DateTime.now().getMillis() - date);

if (duration > 15 * 60 * 1000) {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Signature expired.");
return;

}

Add the Authorization header to the request, and invoke the verify method to
verify the request signature. If the verification is successful, the next filter is
executed. Otherwise, the authentication failed.

apiRequest.addHeader("authorization", authorization);
apiRequest.setKey(signingKey);
apiRequest.setSecret(signingSecret);
Signer signer = new Signer();
boolean verify = signer.verify(apiRequest);
if (verify) {
chain.doFilter(request, response);
} else {
response.sendError(HttpServletResponse.SC_UNAUTHORIZED, "Verify authroization failed.");
}

Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns Hello World!

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.
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Apigateway Signature Test

signature_key1

Secret

signature_secret1

Method Scheme Host Url
POST = http  # | localhost:8080 test
Query
(oo yyy )
y
Headers
{"aaa" bbb’}
Body
dsfasdf=1

Debug

curl -X POST "http://localhost:8080/testhoo=yyy" -H "aaa: bbb" -H "X-Sdk-Date: 20190307T
122402Z" -H "host: localhost:8080" -H “Authorization: SDK-HMAC-SHA256 Access=signatur X

--—-End

6.3 Python

Scenarios

To use Python to sign backend requests, obtain the Python SDK, import the
project, and verify the backend signature by referring to the example provided in
this section.

This section uses IntelliJ IDEA 2018.3.5 as an example.

Preparing the Environment

e  You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Signature Keys" in the AP/
Gateway User Guide.

e You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

e Log in to the APIG console, and download the SDK on the SDKs page by
referring to section "SDKs" in the AP/ Gateway User Guide.

e You have installed Python 2.7.9 or 3.X. If not, download the Python
installation package from the official Python website and install it.

e You have installed Intelli) IDEA 2018.3.5 or a later version. If not, download it
from the official Intelli) IDEA website and install it.
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e You have installed the Python plug-in on Intelli) IDEA. If not, install the
Python plug-in according to Figure 6-4.

Figure 6-4 Installing the Python plug-in

Settings @
Qr Plugins 2 Installed Updates n
» Appearance & Behavior
o] 3
B Search Results (41)
[ ewgine [ MicroPython
* Version Control Languages Framework integration
» Build, Execution, Deployment The Python plug-in provides Support for MicroPython
> Languages & Frameworks smart editing for Python devices in Intelli) IDEA and
scripts. The feature set of the... PyCharm. Features: Code...
RECSE @ " 26,2019 4 25M 3.9 o 12,2019 4 337K 4.9
Live Coding in Python python-typing-adder
Code tools Code toals
Lets you run your Python README Using intelljj to infer
code as you type it. Displays Python typing and add type
variable values, matplotlib, or.. comments using the typing...
& 14, 2018 £ 157K &) 14, 2017 4 214K 2
Install
o
Importing a Project
Step 1 Start Intelli) IDEA and choose File > New > Project.
On the displayed New Project page, choose Python and click Next.
Figure 6-5 New Python
New Project [l
Maven Project SDK: | @ Python 3.7.2 (D:\ §® python.exe) ~ New...
Gradle Additional Libraries and Framewarks:
G Groovy LN Djange
Grails 1€ Google App Engine (Python)
Application Forge [ 2o SQL Support
o Go
“ Go Modules (vgo)
% Dep
‘s App Engine
Static Web
£ Flash Template language:
Templates folder: templates
Application name:
K Kotlin =
Enable Django admin
& Empty Project 2
Cancel Help
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Step 2 Click Next. Click ..., select the directory where the SDK is decompressed, and click

Finish.

Figure 6-6 Selecting the SDK directory of Python after decompression

Mew Praoject

Project name: | p)-'thcunl

Project location: | D¥\java',python

P More Settings

Previous Cancel

Step 3 View the directory structure shown in the following figure.

Figure 6-7 Directory structure

b python
> idea !
> apig_sdk
» licenses

.+ backend signature.py
= main.py

m Python.iml
- test_signer.py

= VERSION
¥ |l External Libraries

» UgpScratches and Consoles
Step 4 Click Edit Configurations.

Figure 6-8 Edit Configurations

o
232

— Edit Configurations...

Help
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Step 5 Click + and choose Flask server.

Figure 6-9 Choosing Flask server

Run/Debug Configurations

I Cucumber java

Add New Configuration

vy Docker 2
& Firefox Remote

% Go App Engine
"L Go Build

._.1 Go Remote
‘v Go Test

Step 6 Set Target type to Script path, select backend_signature.py from the Target
drop-down list box, and click OK.

+ — B F | Name:  Flask (backend_signature.py) [ share [ Allow parallel run
(L Flask server Configuration Logs
{_Flask (backend_signature.py)

> JTemplates Target type: () Module name @ Script path () Custom
Target: ‘\pythoen\backend_signature.py =
Application:
Additional options:
FLASK_ENV: development
FLASK_DEBUG: 0
¥ Environment
Environment variables:
Pythan Interpreter: (0 Use SDK of module:

(®) Use specified interpreter: Python 3.7 =

Interpreter options:
Working directory:
[ Add content roots to PYTHONPATH
[ Add source roots to PYTHONPATH

[7] Cancel Apply

--—-End

Backend Signature Verification Example

This example demonstrates how to build a Flask-based server as the backend of
an APl and implement a wrapper to verify the signature of requests sent from
APIG (APl Management).

(11 NOTE

Signature information is added to requests sent to access the backend of an API only after

a signature key is bound to the API.
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Step 1

Step 2

Step 3

Step 4

Step 5

Compile an interface that returns Hello World! Configure the GET, POST, PUT, and
DELETE methods and the requires_apigateway_signature wrapper.
app = Flask(__name_)

@app.route("/<id>", methods=['GET', 'POST", 'PUT', 'DELETE'])
@requires_apigateway_signature()
def hello(id):

return "Hello World!"

Implement requires_apigateway_signature by putting the signature key and
secret in a dict.

def requires_apigateway_signature():
def wrapper(f):

secrets = {
"signature_key1": "signature_secret1",
"signature_key2": "signature_secret2",
}
authorizationPattern = re.compile(
r'SDK-HMAC-SHA256\s+Access=([A,]+),\s?SignedHeaders=([A,]+),\s?Signature=(\w+)")
BasicDateFormat = "%Y%m%dT%H%M%SZ"

@wraps(f)
def wrapped(*args, **kwargs):
//Signature verification code

return f(*args, **kwargs)
return wrapped
return wrapper

Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The wrapped function is used for signature
verification.

if "authorization" not in request.headers:

return 'Authorization not found.', 401
authorization = request.headers['authorization']
m = authorizationPattern.match(authorization)
if m is None:

return 'Authorization format incorrect.', 401
signingKey = m.group(1)
signedHeaders = m.group(2).split(";")

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find secret based on key. If key does not exist, the authentication failed.

if signingKey not in secrets:
return 'Signing key not found.', 401
signingSecret = secrets[signingKey]

Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

r = signer.HttpRequest()
rmethod = request.method
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ruri = request.path
rquery = {}
for k in request.query_string.decode('utf-8').split('&'"):
spl = k.split("=", 1)
if len(spl) < 2:
rquery[spl[0]] = ""
else:
rquery[spl[0]] = spl[1]
r.headers = {}
needbody = True
dateHeader = None
for k in signedHeaders:
if k not in request.headers:
return 'Signed header ' + k + ' not found', 401
v = request.headers[k]
if k.lower() == 'x-sdk-content-sha256' and v == 'UNSIGNED-PAYLOAD"
needbody = False
if k.lower() == 'x-sdk-date":
dateHeader = v
r.headers[k] = v
if needbody:
rbody = request.get_data()

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.

if dateHeader is None:
return 'Header x-sdk-date not found.', 401

t = datetime.strptime(dateHeader, BasicDateFormat)

if abs(t - datetime.utcnow()) > timedelta(minutes=15):
return 'Signature expired.', 401

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.

sig = signer.Signer()
sig.Key = signingKey
sig.Secret = signingSecret
if not sig.Verify(r, m.group(3)):
return 'Verify authroization failed.', 401

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.

Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the
server returns 200.

If an incorrect key or secret is used, the server returns 401, which means
authentication failure.
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Apigateway Signature Test

signature_key1

Secret

sig\mtw e_secret]

Method Scheme Host Url

POST = http # localhost:8080 test

Query

{00 yyy”)

Headers

{"aaa":"bbb"}

Body

dsfasdf=1

curl -X POST "http://localhost:8080/testPxxx=yyy" -H "aaa: bbb" -H "X-5dk-Date: 20190307T
122402Z" -H "host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur >

--—-End

6.4 C#

Scenarios

To use C# to sign backend requests, obtain the C# SDK, import the project, and
verify the backend signature by referring to the example provided in this section.

Preparing the Environment

e You have obtained the signature key and secret. For details, see Pre-signature
Preparations.

e You have created a signature key on the APIG console and bound it to the API
to be called. For more information, see section "Signature Keys" in the AP/
Gateway User Guide.

e Login to the APIG console, and download the SDK on the SDKs page by
referring to section "SDKs" in the AP/ Gateway User Guide.

e You have installed Visual Studio 2019 version 16.8.4 or a later version. If not,
download it from the official Visual Studio website and install it.
Opening a Project

Double-click csharp.sln in the SDK package to open the project. The project
contains the following:

2023-12-19 72


https://visualstudio.microsoft.com/downloads/

API Gateway
Developer Guide

6 Creating Signatures for Backend Requests

e apigateway-signature: Shared library that implements the signature
algorithm. It can be used in the .Net Framework and .Net Core projects.

e backend-signature: Example of a backend signature. Modify the parameters
as required. For details about the sample code, see Backend Signature
Verification Example.

o sdk-request: Example of invoking the signature algorithm.

Backend Signature Verification Example

Step 1

This example demonstrates how to build an ASP.Net Core-based server as the
backend of an APl and implement an lAuthorizationFilter to verify the signature of
requests sent from APIG (APl Management).

(10 NOTE

Signature information is added to requests sent to access the backend of an API only after
a signature key is bound to the API.

Write a controller that provides the GET, POST, PUT, and DELETE interfaces, and
add the ApigatewaySignatureFilter attribute.

// ValuesController.cs

namespace backend_signature.Controllers
{
[Route("api/[controller]")]
[ApiController]
[ApigatewaySignatureFilter]
public class ValuesController : ControllerBase
{
// GET api/values
[HttpGet]
public ActionResult<IEnumerable<string>> Get()
{
return new string[] { "value1"”, "value2" };

}

// POST api/values

[HttpPost]

public void Post([FromBody] string value)
{

}

// PUT api/values/5

[HttpPut("{id}")]

public void Put(int id, [FromBody] string value)
{

}

// DELETE api/values/5
[HttpDelete("{id}")]
public void Delete(int id)
{
}
}
}

Step 2 Implement ApigatewaySignatureFilter by putting the signature key and secret in

a Dictionary.
// ApigatewaySignatureFilter.cs

namespace backend_signature.Filters

public class ApigatewaySignatureFilter : Attribute, IAuthorizationFilter
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Step 3

Step 4

Step 5

{
private Dictionary<string, string> secrets = new Dictionary<string, string>
{
{"signature_key1", "signature_secret1" },
{"signature_key2", "signature_secret2" },
b

public void OnAuthorization(AuthorizationFilterContext context) {
//Signature verification code

)
}
}

Use a regular expression to parse the Authorization header. The key and
signedHeaders are obtained. The OnAuthorization function is used for signature
verification.

private Regex authorizationPattern = new Regex("SDK-HMAC-SHA256\\s+Access=([A,]+),\\s?
SignedHeaders=([A,1+),\\s?Signature=(\\w+)");

string authorization = request.Headers["Authorization"];
if (authorization == null)
{
context.Result = new UnauthorizedResult();
return;
}
var matches = authorizationPattern.Matches(authorization);
if (matches.Count == 0)
{
context.Result = new UnauthorizedResult();
return;
}
var groups = matches[0].Groups;
string key = groups[1].Value;
string[] signedHeaders = groups[2].Value.Split(';");

For example, for Authorization header:

SDK-HMAC-SHA256 Access=signature_key1, SignedHeaders=host;x-sdk-date,
Signature=e11adf65a20d1b82c25419b5********8d0ba12fed1ceb13ed00

The parsing result is as follows:

signingKey=signature_key1
signedHeaders=host;x-sdk-date

Find secret based on key. If key does not exist, the authentication failed.

if (!secrets.ContainsKey(key))

{
context.Result = new UnauthorizedResult();
return;

}

string secret = secrets[key];

Create an HttpRequest, and add the method, URL, query, and signedHeaders
headers to the request. Determine whether the body needs to be set.

The body is read if there is no x-sdk-content-sha256 header with value
UNSIGNED-PAYLOAD.

HttpRequest sdkRequest = new HttpRequest();
sdkRequest.method = request.Method;

sdkRequest.host = request.Host.Value;

sdkRequest.uri = request.Path;

Dictionary<string, string> query = new Dictionary<string, string>();
foreach (var pair in request.Query)
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{
query[pair.Key] = pair.Value;

sdkRequest.query = query;

WebHeaderCollection headers = new WebHeaderCollection();
string dateHeader = null;

bool needBody = true;

foreach (var h in signedHeaders)

{
var value = request.Headers[h];
headers[h] = value;
if (h.ToLower() == "x-sdk-date")

dateHeader = value;
}
if (h.ToLower() == "x-sdk-content-sha256" && value == "UNSIGNED-PAYLOAD")

needBody = false;

}

sdkRequest.headers = headers;
if (needBody)
{

request.EnableRewind();
using (MemoryStream ms = new MemoryStream())

{
request.Body.CopyTo(ms);
sdkRequest.body = Encoding.UTF8.GetString(ms.ToArray());

}

request.Body.Position = 0;

}

Step 6 Check whether the signature has expired. Obtain the time from the X-Sdk-Date
header, and check whether the difference between this time and the server time is
within 15 minutes. If signedHeaders does not contain X-Sdk-Date, the
authentication failed.
private const string BasicDateFormat = "yyyyMMddTHHmMmssZ";

if(dateHeader == null)
{

context.Result = new UnauthorizedResult();
return;

}
DateTime t = DateTime.ParseExact(dateHeader, BasicDateFormat, Culturelnfo.CurrentCulture);
if (Math.Abs((t - DateTime.Now).Minutes) > 15)

context.Result = new UnauthorizedResult();
return;

}

Step 7 Invoke the verify method to verify the signature of the request, and check
whether the verification is successful.
Signer signer = new Signer();
signer.Key = key;
signer.Secret = secret;

if (!signer.Verify(sdkRequest, groups[3].Value))
{

context.Result = new UnauthorizedResult();

}

Step 8 Run the server to verify the code. The following example uses the HTML
signature tool in the JavaScript SDK to generate a signature.
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Set the parameters according to the following figure, and click Send request.
Copy the generated curl command, execute it in the CLI, and check whether the

server returns 200.

If an incorrect key or secret is used, the server returns 401, which means

authentication failure.

Apigateway Signature Test

Key

Secret

signature_secret1

Method Scheme Host

POST # http  # localhost:8080

Query

{300 yyy"}

Headers

Body

dsfasdf=1

Debug

url

[test

g

curl -X POST "http://localhost:8080/testTx=yyy" -H "aaa: bbb" -H "X-Sdk-Date: 201903077
122402Z" -H "host: localhost:8080" -H "Authorization: SDK-HMAC-SHA256 Access=signatur

--—-End
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Change History

Table A-1 Change history

Date

Description

2023-12-19

This issue is the first official release.
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